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Introduction 
Many companies with remote employees use Microsoft®Terminal Services with Citrix ®1 to deploy 
applications and want to deploy Sage ACT! in the same manner. By implementing Sage ACT! centrally 
on one or more Microsoft Terminal Servers with Citrix, an organization can reap the benefits of 
centralized deployment and maintenance, as well as anytime, anywhere access. Sage ACT! can be 
installed on Microsoft Terminal Servers with or without Citrix.  
 
Although there are some small differences in deployment of Sage ACT! if Citrix is used, the 
differences are the same for any application deployed on a Terminal Server. In this white paper, 
statements regarding the use of Citrix also apply to the use of Terminal Services without Citrix, unless 
a difference is explicitly stated.  
 
Does Sage ACT! run on Citrix? The answer is an emphatic YES, when properly installed, configured 
and deployed on servers with sufficient resources. With very few exceptions, the features of Sage 
ACT! Premium are available on Citrix. 
 
Features not supported: Integration with a fax is supported via normal fax integration on Windows® 

2003 (i.e., the fax looks like a printer). Integration with an automatic dialer is not supported. The Sage 
ACT! Scheduler is also not supported. 
 
This white paper explores the benefits of deploying Sage ACT! Premium through Terminal Services, 
outlines deployment requirements and recommendations, and provides installation and performance 
tips. It is intended for IT Administrators who are considering deployment of Sage ACT! using Microsoft 
Terminal Services, with or without Citrix. Please note that Citrix compatibility is available in both Sage 
ACT! Pro and Sage ACT! Premium. Setup for each is very similar and differs primarily around the 
feature set differences between Sage ACT! Pro and Sage ACT! Premium. For the purposes of this 
white paper, we are using Sage ACT! Premium as the example; when Sage ACT! is used for brevity, it 
refers to Sage ACT! Premium.  
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Deployment Options 
The following sections compare the traditional Sage ACT! Premium desktop deployment and a simple 
deployment using Terminal Services and/or Citrix. Also outlined are the organizational benefits of 
deployment using Terminal Services and/or Citrix.  

Desktop Deployment of Sage ACT! Premium 
In a desktop deployment, Sage ACT! (and any software that Sage ACT! will integrate with, such as 
Microsoft Office), is installed locally on each user’s computer. The database is often centralized, 
typically using Microsoft SQL Server®, allowing the group to share contact information.  
 
Each user has a personal login. This personal account allows individual email and scheduling and 
permits the software to track activities associated with a contact to the individual user. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure1 :  Desktop Deployment without Terminal Services or Citrix 
 
As with any installed application, each computer with Sage ACT! needs to be individually and 
physically managed for installation, set-up, and maintenance (other than that which can be handled 
through the database). This is manageable in small deployments, but becomes more challenging with 
larger user counts, greater computer variety, and remote users. For remote users, the Sage ACT! 
Premium database is often centralized with secure access through a Virtual Private Network (VPN). 
Remote Sage ACT! users can choose real-time database access or periodic synchronization. To 
simplify remote deployments, provide administration flexibility, and increase security, companies often 
look to deploy Sage ACT! through Terminal Services and/or Citrix.  

To simplify remote 
deployments, provide 
administration flexibility, 
and increase security, 
companies often look to 
deploy Sage ACT! through 
Terminal Services and/or 
Citrix. 
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Simple Deployment using Terminal Services and/or Citrix 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 2:  Simple Citrix2 Deployment 
 
In this deployment, Sage ACT! (and the software it integrates with) is installed once – on the Citrix 
Server3. The only software needed on the end user’s computer is a Citrix ICA client and, optionally, a 
web browser4.  
 
The administrator performs additional setup activities on the Citrix Server for each user of Sage ACT!; 
this is faster than installing and configuring each computer. All maintenance activity is also centralized 
– so the administrator no longer has to visit the users’ desks. Tools that come with Citrix, such as 
session shadowing, allow the administrator to view and/or take control of a user session. This 
dramatically increases both user and administrator productivity. 
 

Benefits of Deploying Sage ACT! Premium Using Terminal Services and/or Citrix 

Deploying Sage ACT! using Terminal Services and/or Citrix has advantages for both users and 
administrators. 
 
Benefits to Users:  

• No need to install, configure, or manage Sage ACT! on user computers. All set-up and 
administration is performed by others. 

• In addition to Windows PCs, Sage ACT! can be available from a range of computers 
including Macintosh®, Linux PCs, thin clients, etc. 

• Anytime, anywhere access to Sage ACT!. 
• Due to low bandwidth requirements, Sage ACT! users may experience improved 

performance on less robust hardware. The same is true for remote users on a high latency 
WAN. 

 
 
 

2  A deployment using native Terminal 

Services without Citrix is logically the 

same. 

Using Terminal Services 
and/or Citrix, Sage ACT! can 
be made available on 
computers other than 
Windows PCs, including 
thin clients, Macintosh, 
Linux PCs, or any device 
with an RDP or ICA client. 
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Benefits to Administrators:  

• Central installation and maintenance of the Sage ACT! application and database. 
• Sage ACT! deployed as part of a published desktop or published application (Citrix). 
• Easily “shadow” Sage ACT! users for troubleshooting and/or training. 
• Enhanced Sage ACT! security using SSL and strong authentication methods. 
• Better Sage ACT! performance from a range of different machines, network topologies, and 

network latency. 
• Sage ACT! deployment and administration consistent with other applications. 

 
Using Terminal Services and/or Citrix, Sage ACT! can be made available on computers other than 
Windows PCs, including thin clients, Macintosh®, Linux PCs, or any device with an RDP or ICA client. 
Users also benefit from increased Sage ACT! access, since deploying Sage ACT! on the Terminal 
Server allows user access from any computer. This includes computers elsewhere in the building or 
outside the office. Sage ACT! users can work from home on their personal computers, on the road in a 
hotel, at an Internet café, or wherever Wi-Fi is available, without having to install software.  
 
When deployed using Terminal Services and/or Citrix, the memory and CPU requirements on 
individual user desktops and notebooks are significantly reduced. On the Terminal Server, each user 
is running a copy of Sage ACT!. While the Terminal Server will be a more robust computer than a 
typical desktop PC, adding more users erodes a single server’s ability to sustain desired performance. 
As user counts increase, multiple servers can be deployed, as shown in Figure 3. Adding additional 
servers and leveraging built-in load balancing make it easy to add additional users and/or enhance 
performance levels. Please note that due to the resource requirements of a robust application like 
Sage ACT!, administrators should carefully monitor the number of users per Terminal Server and 
adjust the number of concurrent users per server to align with performance requirements. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Sage ACT! Premium Licensing on      

Terminal Servers and/or Citrix 
 

Although only one copy of Sage ACT! is 
installed, each user connecting to Sage 

ACT! 
needs a valid license count in Sage ACT!. 

Therefore, the serial number installed 
and activated in Sage ACT! must have 
sufficient licenses to accommodate all 
users accessing Sage ACT! via Citrix. 

When Sage ACT! is 
deployed using Terminal 
Services and/or Citrix, the 
memory and CPU 
requirements on individual 
user desktops and 
notebooks are significantly 
reduced.

3 The SQL Server Database can be 

installed on the Citrix Terminal Server. 

 

4 If native Terminal Services is used 

without Citrix, then the Microsoft Remote 

Desktop Connection Client is needed. 

This is part of Windows XP, but can be 

downloaded for older operating systems. 
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Figure 3: Multiple Citrix Servers and Remote Access 

Load Balancing 
While individual users may be assigned to specific servers, it is more common to use a load balancer. 
For Sage ACT!, DNS round-robin load balancing (such as Windows Network Load Balancer, which 
often is used in a web farm) is sufficient. Citrix also has a load balancer that can be used to monitor 
the number of concurrent sessions and optimally assign user connections. This is often superior to 
DNS because it is more intelligent in how it determines which server to access. When users might be 
assigned to different servers by a load balancer, Roaming Profiles are typically used so that user-
specific settings5 follow the user, no matter which server they are connected to.  
 

Note: Load balancing and roaming profiles are not covered further in this white paper 
because there is nothing specific about deploying Sage ACT! with these components that is 
different than for any other application. However, they are an important part of deployment 
considerations. 

Deploying Sage ACT! using 
Terminal Services/Citrix 
provides secure, remote 
access to critical contact 
and customer information. 
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Secure Remote Access 
Secure remote access to Sage ACT! data is a critical requirement for the user, administrator, and 
company. There are several options to choose from. A VPN access solution for remote users is one 
option. Typically, the VPN device exists in an organization’s network Demilitarized Zone (DMZ), 
between the outside and inside firewalls. Citrix offers two additional options: the Citrix Secure Gateway 
(CSG) and the Citrix Access Gateway (CAG). 
 

• CSG is software added to a Microsoft server placed within the DMZ. Remote users access 
the CSG via a web browser using Secured Sockets Layer (SSL). Once users authenticate 
within the DMZ, they are granted access to the Citrix Servers inside the firewall. 

• CAG is dedicated hardware that acts as a hardened SSL/VPN appliance for use in the DMZ. 
This provides a more secure access solution.  

 
Though not shown in the deployment illustrations, these products are transparent from within Sage 
ACT! and are recommended for their security benefits. 
 
Customers without VPN access via Citrix may use an existing VPN (Cisco® or others) for remote 
access through the firewall. Directly exposing the Microsoft Terminal Server RDP (port 3389) or Citrix 
ICA (port 1494 or 2598) ports to the outside world is not recommended because of the likelihood of 
attacks against them. Some enterprises that expose RDP or ICA protocols directly (rather than 
through SSL) renumber these ports, but port scanners can still find them. More information on 
securing the access is available from Microsoft and Citrix, as well as many Terminal Server-oriented 
web sites. 

System Requirements 
The minimum system requirements for Sage ACT! Premium are all that is required for using Sage 
ACT! in a Citrix environment. Sage ACT! Premium system requirements can be found at 
http://www.act.com/2011systreq. For Citrix Presentation Server system requirements, check with your 
Citrix representative. 
 
In planning the system, the administrator should consider Sage ACT! as a substantial platform to be 
added to the server(s), since users typically leave Sage ACT! open all day long. 

Additional Notes When Considering System Requirements  
• Turning on HyperThreading may yield about 1.8 processor equivalents for Sage ACT! 

(recommended administrators only enable on Windows 2003 systems). 
• Two separate drives are preferable to a single drive. This is often referred to as “two 

spindles.” When using two drives, install OS/page file on the first drive, and install Sage ACT! 
and its database on the second drive.  

• The initial database file of 20 MB is included in this number. Administrators should also 
consider the amount of additional disk space to reserve to accommodate growth. Additional 
disk space for growth of the database should also be considered. (Keep in mind that if Sage 
ACT! internal email software is used, those emails will be stored in the database.) 

• Sage ACT! Premium installation requires 1000 MB of disk space. Most of this space is used 
in the installation folder selected by the installer; however, a sizable portion is installed in the 
Windows GAC (Global Assembly Cache). Each Sage ACT! user will require an additional 30 
MB in their profile folder. 

5  For example, this includes the user’s 

“My Documents” folder, application 

shortcuts, and registry settings affecting 

user-specific application customizations. 
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At runtime, each concurrently logged in Sage ACT! user will use 80-95 MB of memory for Sage ACT! 
itself. If the Sage ACT! internal email is used, the user will require an additional 15-20 MB. If the server 
has insufficient memory resources, user scalability6 is impacted. 
 
Sage ACT! uses significant CPU resources as well. When the user has Sage ACT! open but is not 
actively working with it, the CPU resources are minimal. When actively using ACT!, the user will 
consume significant CPU resources in short bursts. The activity level of the users will limit the 
scalability7 on the Terminal Server. 

Installing Sage ACT! Using Terminal Services and/or Citrix  
This section provides guidance to an administrator who is installing Sage ACT! on a Terminal Server 
and/or Citrix. Consult the Installing Sage ACT! for New Users guide for the most current information on 
installing Sage ACT!. 

The administrator installs Sage ACT! and related software in this order: 

1. Install Terminal Services and/or Citrix on the server8.  
2. Install any software that Sage ACT! integrates with, such as Microsoft Outlook® and Word. 
3. Install Sage ACT! Premium.  

 
The administrator performs all installation activities with the Terminal Server in “install mode.” The 
recommended method to install Sage ACT! in a Terminal Server and/or Citrix setting is listed on the 
next page. 
 
Order Action Where Taken 

1 Installing the database server 
software  

On the PC that will house the database 

2 Installing Sage ACT!  On each server that will house Sage ACT! 
users via Citrix or Terminal Server 

3 Activating and registering Sage ACT! 

4 Performing site-specific 
customizations 

5 Deploying Sage ACT! for multi-user 
access 

6 Publishing Sage ACT! as a Citrix-
published application 

Once, from any machine with the Citrix 
Management Console installed 

7 Initializing individual user setups For each user (with roaming profiles, this 
can be done on any Terminal Server and/or 
Citrix) 

 
The following sections provide details for each step in the chart above. 
 
Step 1: Installing the Database Server Software 
The Sage ACT! installer guides you through the installation of the components necessary, including 
SQL Server, the Service Pack, and the hot fix, and through the creation of the Sage ACT! database. 
You install the software only on the machine that will host the database. 
 

6  Scalability will vary based on hardware 

and size and usage of your database. 

Published minimum system requirements 

found at www.act.com/2011systreq are 

based on single user environments. You 

must purchase one license of Sage ACT! 

per user. 

 

7  Scalability will vary based on hardware 

and size and usage of your database. 

Published minimum system requirements 

found at www.act.com/2011systreq are 

based on single user environments. You 

must purchase one license of Sage ACT! 

per user. 

 

8  See www.act.com/2011systreq for 

Service Pack and other requirements, 

such as for Microsoft .NET Framework. 

Using Terminal Services 
and/or Citrix, the 
performance requirements 
of the user’s client machine 
are reduced, since the only 
software running on the 
client is a browser and/or 
ICA/RDP client. 
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Do the following: 
1. If you have installed or uninstalled any version of SQL Server (including SQL Server 

Express) from the server, reboot the server before starting this installation.  
2. First, install the database. Follow the instructions on screen. Be patient, as progress in some 

cases is not evident for some time.  
3. Reboot the system after installation is complete. 

 
Note: You must be a System Administrator to perform this installation and use the “Change 
user/install” command before installation.  

 
The DVD installs SQL Server and the Service Packs, and it creates and starts the Sage ACT! 
instance. It also installs a file that users utilize to access the database. This file, called a PAD file, 
needs to be accessible to Sage ACT! users. When the database is on a separate machine, the PAD 
file is usually made available via a shared folder or mapped drive. 
 

4. Make the PAD file available (read-only) to all users, via a shared folder or mapped drive. 
 
Step 2: Installing Sage ACT! 
Once the database is in place (and the system has been rebooted), you can install Sage ACT! 
program files on the Terminal Servers. The basic installation, allowing the Administrator to run Sage 
ACT!, is simple.  
 
Do the following: 

1. Log on to the server as an Administrator. 
2. Change user/install. 
3. Launch the installer. 
4. Follow the instructions. 
5. Near the end of the installation is an option to launch Sage ACT!. Because the server is in 

install mode, do not select this option. 
6. After installation is complete, Change user/execute. 

 
Step 3: Activating and Registering Sage ACT! 
The Administrator starts Sage ACT! to obtain any available updates from the web, set standard 
preferences, and create the database. 
 
Each user requires access to the database file. By default, Sage ACT! suggests a location for the PAD 
file in the profile of the user who creates the database. In the Terminal Server environment, this 
location should be overridden. 
 

• In a single Terminal Server environment, a new subfolder in the install folder may be 
appropriate, or the administrator may choose another location.  

• If multiple, load-balanced, Terminal Servers are in use, a single machine should be 
responsible for hosting the database files, and it should be made available via a mounted 
share. Select the option to “Share this database with other users” when creating the 
database; the folder selected for the database will be mounted for you as a share. Default 
permissions for this share are Read/Write for “Everyone”, since Sage ACT! users need full 
access to this folder. Share this folder only if multiple servers are used, not if multiple users 
access one server. 
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Do the following: 
1. Log on as an Administrator to the server that has Sage ACT! installed and that will house the 

database. 
2. Change user/install. 
3. Create any folders or mapping needed for the database. 
4. Launch Sage ACT!. 
5. When prompted to check for updates, click Yes. Follow the instructions that appear. 
6. When the Registration and Activation Wizard appears, follow the instructions. 
7. When the Getting Started Wizard appears: 

 
• Step 1: Selecting the “In the future, hide this page” option only affects this user. Click 

Next. 
• Step 2: Select a word processor (Sage ACT! or other, if detected), and then click Next. 
• Step 3: Select Skip email Setup, and then click Next (if the administrator is not a regular 

user of Sage ACT!). 
• Step 4: If a database has not been created, select Create new database, and then click 

Next. 
• Step 5: Select a database name. Change the location to the shared folder where the 

database file will reside. Select the Share this database with other users checkbox.  
• Enter a user name and password, and then click Next.  

o Note: This is a user name and password for this Administrator to open the 
Sage ACT! database. This name/password will have full Administrator rights to 
the database. 

• Step 6: Click Finish. 
8. Sage ACT! opens. You may be prompted to import Outlook contacts, even if email was not 

set up, and Outlook is not installed. Click No (if the Administrator does not normally use 
Sage ACT! from this account). 

9. If user teams are desired, from the menu bar, select Tools > Manage Teams. For each Sage 
ACT! team, select Create Team. 

10. From the menu bar, select Tools > Manage Users. For each Sage ACT! user licensed, select 
Create New User. 

11. Continue with any other site/tenant-specific customizations (such as in Tools > Preferences). 
12. Exit Sage ACT!. 
13. Change user/execute. 
14. On additional servers, follow the same steps, except in step 4, skip database creation and 

open the shared database mounted from another server via the “PAD” file. 
 
Step 4: Performing Site-Specific Customizations 
Sage ACT! can be customized by end users. Generally, these customizations are stored in XML-
formatted files under the user profile folder. The preferred method of customization is to use Sage 
ACT! to modify these preferences. The Administrator should make company-specific customizations 
before deploying to users (see “Multi-User Deployment,” which follows this section).  
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Do the following: 
1. Log on as the Administrator who installed the software. 
2. Change user/execute. 
3. Launch Sage ACT!. 
4. Change settings and preferences as desired. These settings should be site-specific, not 

user-specific. Although these settings will be the default, users can override them. 
5. Exit Sage ACT!. 

 
Step 5: Deploying for Multi-User 
The Administrator needs to copy shortcuts and files from the Administrator’s profile to the All Users 
profile. After this is done, when users run Sage ACT! and change their profiles, the changed files are 
copied to the users’ profiles. The Sage ACT! XML files are stored in a Sage ACT! folder in the user’s 
hidden “Application Data” folder.  
 

Note: After deploying Sage ACT! to multiple users, the Administrator could make company-
wide customizations by manually editing the XML files for each user. If users have not 
modified their profiles, the Administrator can manually edit the file copy in the All Users 
profile. 

 
Do the following: 

1. Log on as a system administrator. 
2. Open Windows Explorer.  

Note: You must be able to view hidden files and folders. To set this option, in 
Windows Explorer: Tools > Folder Options > View Tab. 

3. For a full desktop deployment: 
• In the folder: C:\Documents and Settings\All users\Start Menu\Programs\ACT! Premium, 

remove the Uninstall shortcut and any others desired. 
 

Note: If only a subset of the server users will use Sage ACT!, you might want to remove 
all the shortcut entries from the All users start menu. 

 
• Browse to C:\Documents and Settings\All Users\Start Menu\Programs\Startup. 
• If desired, delete the Service Manager shortcut. This puts an SQL Server manager 

shortcut into the tray icon area of the desktop, which is probably not appropriate for 
most users. 
 
Note: The desktop shortcut to Sage ACT! is only added to the desktop of the user that 
did the installation. For a full desktop deployment, you might move that shortcut to the 
All Users desktop instead. 
 

4. Go to the C:\Documents and Settings\All Users\Application Data\ folder. Copy the Sage 
ACT! folder from the Administrator’s account (C:\Documents and Settings\name-of-
administrator\ 
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Step 6: Publishing Sage ACT! as a Citrix Application 
This step is taken once Sage ACT! is installed on all servers in a farm or silo. 
 
In a Citrix installation, some enterprises use published applications rather than published desktops. 
The administrator can add Sage ACT! as a published application as described in the following 
procedure. (The procedure example uses Citrix Presentation Server 4.5; however, the steps are 
similar for other Citrix versions.) 
 
Do the following: 

1. Start the Citrix Management Console and log on to the farm. 
2. Right-click on Applications, and then select Publish Application. 
3. Enter Display Name and a description (“ACT!”). 
4. For the Application Type, select Application. Browse for the command line, selecting 

ACT8.exe from the installation folder (generally, under Program Files). Click Next. 
5. Specify servers: Add each server Sage ACT! was installed on. 
6. Specify users: Because personalization files are stored in each user’s profile, do not select 

Allow Anonymous Connections. 
 
Web Browser Redirection7, if used, will work for online Help and requests for maps. Product 
registration and updates require the use of the browser on the server. 
 
Step 7: Initializing Individual User Setups 
For integration with email, the Administrator can: 

• Log on as each user to perform per-user customizations; or•  
• Provide information to users and ask them to perform these steps.•  

Setting up email integration can be done either by using the Setup Assistant or through Preferences 
(Tools > Preferences > Email Tab > Email System Setup). For the purposes of this white paper, we 
have documented setup using the Setup Assistant.  
 
Integration with Internet Mail 
The Internet Mail feature of Sage ACT! is an email client that stores mail in a single email database 
that all users share. This client uses folders much like Outlook does and is capable of handling all user 
email needs. The client integrates with SMTP/POP3 servers to deliver and receive email. The email 
address for the SMTP server should be set up before performing this step. 
 

1. Launch Sage ACT! as a user. 
2. The upgrade option appears. Ignore. 
3. The register option appears if the application has not been registered. This is another item 

the Administrator can move to the console. Ignore. 
4. Getting started appears (even though we checked it before). Select the checkbox In the 

future, hide this page, and then click Next. 
5. Select the appropriate word processor. Click Next. 
6. Select Set up email, Internet Mail. Click Next. 
7. Select Default Account: Enter the user name for the email account, and then click Next. 
8. On the User Information tab, fill in the Account name and other fields, as appropriate. Also fill 

in information on other tabs, as appropriate. Test the account connection, and then click OK. 
9. Click Next twice. 
10. Database Setup: Select Skip database setup. Click Next. 
11. Click Finish. 
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12. Select Open Database, and then select the PAD file in the shared folder. 
13. Enter the user name and password, and then click OK. 
14. In the Contact Detail view for the user, enter the email address. 
15. Exit Sage ACT!. 

 
Repeat these steps for each user. 
 
Integration with other email programs 
Integration with other email programs, such as Outlook or Outlook Express, follows the same strategy 
as for the Sage ACT! Internet Mail. Simply complete steps 1-5. In Step 6, instead of selecting Internet 
Mail, select the supported Sage ACT! email program you want to integrate with and follow the Wizard 
from there.  
 
Multi-Tenancy Setup 
Multi-Tenancy refers to an Application Service Provider (ASP), where multiple, independent customers 
are supported by the same server. It also applies to an Enterprise where distinct groups want to use 
different databases. There are set-up issues to consider for multi-tenancy. 
 
Sage ACT! can work in a multi-tenant setup if self-provisioning is not a desired feature. Each tenant 
will have a unique database. The Administrator should create each database in a different folder and 
put appropriate Access Control List (ACL) protections in place to prevent other tenants from accessing 
them.  
 
With Multi-Tenancy, the Administrator does not copy files into the All Users profile. The easiest 
approach is for the Administrator to use a different Windows administrator account for each tenant.  
The Administrator logs into each Windows administrator account and completes the steps under 
Deploying for Multi-Users, except for copying the Sage ACT! folder into the All Users folder. Instead, 
the Administrator copies these files into each user’s profile for that tenant. 

Summary 
Sage ACT! Premium can be effectively deployed using Microsoft Terminal Services and Citrix. There 
are numerous benefits:  

• Lower maintenance costs resulting from component centralization. Sage ACT! components 
are installed centrally on a few servers. The Sage ACT! Administrator no longer has to go to 
individual computers to perform maintenance tasks. 

• Secure remote access for those on the road. This configuration provides access to the data 
without it ever leaving the building or campus. Sage ACT! users can access the data 
wherever they are as long as they have an active network connection. 

• Fewer ports exposed through the firewall. 
• Typically, less WAN traffic for a remote user than with a traditional remote desktop 

installation with VPN access. 
• Sage ACT! can be deployed to a user base of various computers such as Macintosh, thin 

clients, Linux PCs, etc. 
• Performance requirements of the user’s client machine are reduced since the only software 

running on the client is a browser and/or ICA/RDP client. 
• Enhanced training opportunities that allow an Administrator to “shadow” a user’s session to 

either walk the user through using the software or take control of the session and perform a 
task. 
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Appendix  

Knowledgebase Articles  
Knowledgebase articles related to Sage ACT! deployment on Citrix or Terminal Services. 
 

Sage ACT! Version  Knowledgebase  Knowledgebase Article 
Title 

Comments 

ACT! by Sage 2010 
& 2009 Product 
Family 

24086 How to Integrate ACT! 
by Sage and Microsoft® 
Outlook® in the Citrix® 
Environment 

 

ACT! by Sage 2010, 
2009, 2008, & 2007 
Product Family 

23701 Email History Fails to be 
Recorded Using 
Outlook® Integration in a 
Citrix® Environment 

 

ACT! by Sage 2010, 
2009, 2008, 2007, & 
2006 Product Family 

25672 Clipboard Operations 
Not Functioning in 
Citrix® Environment 

 

ACT! by Sage 2010, 
2009, 2008, 2007, & 
2006 Product Family 

18046 Cannot Attach a Web 
Page to ACT! Contacts 
in a Citrix® Environment 

 

ACT! by Sage 2010, 
2009, 2008, 2007, & 
2006  Product 
Family 

15275 Using ACT! with Citrix® 
or Terminal Server 

Inquire with Citrix® 
regarding Citrix® 
system 
requirements 

ACT! by Sage 2006 
Product Family 

17444 How to Download and 
Apply the Citrix® Email 
Hotfix 

 

ACT! by Sage 2006 
Product Family 

17449 Unable to Attach Emails 
to Contacts When Using 
ACT! in a Multi-User 
Citrix Environment 

 

ACT! by Sage 2006 
Product Family 

17446 You See Another ACT! 
Users Email Inbox 

 

ACT! by Sage 2006 
Product Family 

17447 You See Another Users 
Signature When Using 
ACT! Email 

 

ACT! by Sage 2006 
Product Family 

17448 You See Another Users 
Address Book When 
Using ACT! Email 

 

ACT! by Sage 2006 
Product Family 

18061 Mail Merge Fields From 
Another Database are 
Available to Add to Your 
Template 
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ACT! by Sage 2006 
Product Family 

17450 You See Another ACT! 
Users Contact List When 
Attempting to Attach an 
Email 

 

ACT! by Sage 2006 
Product Family 

16493 Only One User Can 
Open ACT! When Using 
Through Terminal 
Services 

 

ACT! by Sage 2006 
Product Family 

16761 Multiple ACT! Processes 
Create in Terminal 
Server/Citrix® 
Environment 

 

ACT! by Sage 2006 
Solutions Family 

18405 When More Then One 
User is Connected via 
Citrix® to ACT! User is 
Unable to Create New 
Database 

 

ACT! by Sage 2006 
Product Family 

17973 Export to Excel® Not 
Active and Cannot 
Select Microsoft Word® 
as the Default Word 
Processor When Using 
the Database Through 
Terminal Services 

 

ACT! by Sage 2006 
Product Family 

16688 Error: “Exception has 
been thrown by the 
Target of an Invocation.” 
Or “Error Number: 
0x80040000” When 
Installing ACT! Link for 
QuickBooks®. 

Only local 
installations of the 
ACT! Link for 
QuickBooks 
application are 
supported. 

ACT! by Sage 2006 
Product Family 

16687 Error: “Failure to 
configure server” When 
Attempting to Install SQL 
Server 2000 or MSDE 

This error will result 
if you attempt to 
install SQL Server 
2000 or MSDE 
across a network 
connection or on 
any machine using 
a remote desktop 
application, 
including Citrix or 
Terminal Services.  

 
 
 
 
 
 
 



About Sage ACT! 
Sage ACT! makes it easy for you to have meaningful conversations with customers by giving you an organized view of the people you do business with. 
Like the millions of small businesses and sales teams who use Sage ACT!, you’ll always be prepared with recent emails, meeting notes, task reminders, 
and social media profiles, because all of these details live in one place. 
 
Important Note: Review Sage ACT! system requirements at www.act.com/2011systreq. You must purchase one license of Sage ACT! per user. 
Scalability varies based on hardware, size, and usage of your database. Compatibility: Visit www.actsolutions.com or contact your add-on product 
provider to help determine compatibility. 
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